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IMPORTANT: PLEASE READ THIS SOFTWARE 
LICENSE AGREEMENTBEFORE USING THE 
SOFTWARE. BY USING THE SOFTWARE, YOU ARE TO 
BE BOUND BY THE TERMS AND CONDITIONS 
STATED. IF YOU DO NOT AGREE WITH THE TERMS OF 
THIS LICENSE,RETURN THE UNUSED SOFTWARE TO 
THE POINT OF PURCHASEYOUR MONEY WILL BE 
REFUNDED.

1. License. (a)If your license is for Eudora Planner. 
QUALCOMM Incorporated (“QUALCOMM”) grants to the 
Licensee purchasing this copy of Eudora Planner Software 
a nonexclusive, nontransferable license to use the Eudora 
software and other software and fonts contained in this 
package (collectively the “Software”) and its 
documentation for use in accordance with this License. 
QUALCOMM or QUALCOMM's Licensors retain title to the 
Software and related documentation although the 
Licensee owns the media on which the Software and 
documentation are recorded, if any. 

This License allows use of the Software and 
documentation only by the number of Users and on the 
platform specified on the UPC label on the diskette(s) or, 
for electronic transactions, the number of Users licensed. 
“User(s)” means Licensee, if Licensee is an individual 
purchasing the Software for use at office or home, or, if 
Licensee is a corporation or similar business or 
commercial entity or government agency, its current 
employees. For qualifying educational institutions, “Users” 
also means faculty and staff teaching for or employed by 
Licensee and registered students enrolled at a single 
campus operated by Licensee. Subject to the limitations of 
this License, each authorized User may only use the 
Software on (i) any central processing unit (“CPU”), 
workstation or portable which is owned or controlled by 
Licensee, and (ii) any User-owned CPU, workstation or 
portable. 

(b)If your license is for Eudora Group Planner. 
QUALCOMM Incorporated (“QUALCOMM”) grants to the 
Licensee purchasing this copy of Eudora Group Planner a 
nonexclusive, nontransferable license to use one copy of 
the Eudora Group Planner software and other software 
contained in this package (collectively the “Software”) and 
its documentation in accordance with this License. 
QUALCOMM or QUALCOMM’s Licensors retain title to the 
Software and related documentation and all copies thereof 
although the Licensee owns the media on which the 
Software and documentation are recorded, if any. This 
License allows use of the Software and documentation for 
up to the number of accounts licensed for Licensee's 
internal business purposes. Licensee may only use the 
Software on one computer system at a time which shall be 
owned or controlled by Licensee.     

For Trial Version Customers of either Eudora Planner or 
Eudora Group Planner. This License allows use of the 
Software for a period of up thirty (30) days after initial 
download for demonstration and evaluation purposes only 
on the platform licensed for Licensee’s internal business 
purposes. Licensee may only use the Software on one 
central processing unit at a time which shall be owned or 
controlled by Licensee. This Software is not for resale. 

2. Restrictions. This License sets forth the terms and 
conditions governing the use of the Software and 
documentation. Licensee may not rent, lease or otherwise 
transfer the Software or its documentation. Licensee may 
make a limited number of copies of the Software based on 
the number of licensed Users and a reasonable number of 
back-up copies. The Software contains copyrighted 



iii
material, trade secrets and other proprietary material. 
Licensee must reproduce on all such copies of the 
Software the copyright notices and any other proprietary 
legends that were on the original copy of the Software. 
Licensee shall not, without the prior written permission of 
QUALCOMM, nor permit anyone else to, decompile, 
reverse engineer, disassemble or otherwise reduce the 
Software to a human perceivable form, or to modify, 
network, rent, lease, loan, distribute, or create derivative 
works based upon the Software or the documentation in 
whole or in part. Notwithstanding, 

if the Software is lawfully acquired outside of the United 
States within a jurisdiction which is a member of European 
Economic Community (EEC) subject to the EEC Council 
Directive of May 14, 1991, Licensee agrees that within that 
jurisdiction it shall not, and shall not allow any party on 
Licensee’s behalf, to attempt to reverse engineer or 
decompile the Software into another computer language, 
except as expressly and specifically provided in the EEC 
Council Directive of May 14, 1991. Any and all information 
obtained during such lawful reverse engineering and/or 
decompiling activities, including but not limited to, the 
organization, logic, algorithms and processes of the 
Software, shall be deemed to be the confidential and 
proprietary information of QUALCOMM or its Licensors. 
Licensee shall not make copies of the copyrighted 
Software documentation without the prior written 
permission of QUALCOMM provided that for electronic 
transactions, Licensee may make one (1) hard copy of 
such documentation for each User.

3. Technical Support. Licensee must register in order to be 
eligible for technical support via telephone or electronic 
mail. For a period of ninety(90) days, commencing with the 
date of Licensee’s first telephone call requesting support, 
Licensee will have access to technical support for the 
Software for the technical contact designated on the 
product registration card included with this package or 
specified via electronic mail registration, subject to 
Licensee’s compliance with QUALCOMM’s instructions for 
accessing such support and standard verification 
procedures.   Upon the expiration of the above-described 
ninety (90) day period, Licensee may extend technical 
support on a per-incident or annual fee basis in 
accordance with QUALCOMM’s then current pricing and 
terms. Upgrades to the Software and its documentation, if 
any, are not included and may be sold separately.

4. Termination. This License is effective until terminated. 
Licensee may terminate this License at any time by 
destroying all copies of the Software and its 
documentation. This License will terminate immediately 
without notice from QUALCOMM if Licensee fails to 
comply with any provision of this License. Upon 
termination, Licensee must destroy all copies of the 
Software and its documentation.

5. Export Law Assurances. Licensee agrees and certifies 
that neither the Software nor any other technical data 
received from QUALCOMM, nor the direct product thereof, 
will be exported outside the United States except as 
authorized and as permitted by the laws and regulations of 
the United States. If the Software has been rightfully 
obtained by Licensee outside of the United States, 
Licensee agrees that Licensee will not re-export the 
Software nor any other technical data received from 
QUALCOMM, nor the direct product thereof, except as 
permitted by the laws and regulations of the United States 
and the laws and regulations of the jurisdiction in which 
Licensee obtained the Software. The Software may not be 
exported to any of the following countries: Cuba, Iran, Iraq, 
Libya, North Korea, Sudan or Syria.

6. Government End Users. If Licensee is acquiring the 
Software on behalf of any unit or agency of the United 
States Government, the following provisions apply. The 
Government agrees: (i) if the Software is supplied to the 
Department of Defense (“DOD”), the Software is classified 
as “Commercial Computer Software” and the Government 
is acquiring only “restricted rights” in the Software and its 
documentation as that term is defined in Clause 252.227-
7013(c)(1) of the DFARS; and (ii) if the Software is 
supplied to any unit or agency of the United States 
Government other than DOD, the Government's rights in 
the Software and its documentation will be as defined in 
Clause 52.227-19(c)(2) of the FAR or, in the case of 
NASA, in Clause 18-52.227-86(d) of the NASA 
Supplement to the FAR or the successor clauses to any of 
these clauses.

7. Limited Warranty on Diskettes. (Not applicable to 
Software purchased electronically.) QUALCOMM warrants 
the diskettes on which the Software is recorded to be free 
from defects in materials and workmanship under normal 
use for a period of ninety (90) days from the date of 
purchase. QUALCOMM's entire liability and Licensee's 
exclusive remedy will be replacement of the diskettes not 
meeting QUALCOMM's limited warranty and which are 
returned to the place of purchase within such warranty 
period. QUALCOMM will have no responsibility to replace 
a diskette damaged by accident, abuse or misapplication. 
ANY IMPLIEDWARRANTIES ON THE DISKETTES 
INCLUDING THE IMPLIED WARRANTIES 
OFMERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE LIMITED INDURATION 
TO NINETY (90) DAYS FROM THE DATE OF 
PURCHASE.

8. Disclaimer of Warranty. Licensee expressly 
acknowledges and agrees that the use of the Software and 
its documentation is at Licensee's sole risk. The Software, 
documentation, and technical support are provided “AS 
IS” and without warranty of any kind. Information regarding 
any third party services included in this package, if any, is 
provided as a convenience only, without warranty by 
QUALCOMM, and will be governed solely by the terms 
agreed upon between Licensee and the third party 
providing such services.TO THE MAXIMUM EXTENT 
PERMITTED UNDER APPLICABLE LAWS,QUALCOMM 
AND QUALCOMM'S LICENSOR(S) (FOR THE 
PURPOSES OF PROVISIONS 8 AND 9, QUALCOMM 
AND QUALCOMM'S LICENSOR(S)SHALL BE 
COLLECTIVELY REFERRED TO AS QUALCOMM) 
EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING, BUTNOT LIMITED TO THE 
IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, AND 
NONINFRINGEMENT. QUALCOMM DOES NOT 
WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
SOFTWARE WILL MEET LICENSEE'S 
REQUIREMENTS, OR THAT THEOPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-
FREE,OR THAT DEFECTS IN THE SOFTWARE WILL BE 
CORRECTED. FURTHERMORE, QUALCOMM DOES 
NOT WARRANT OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE OR ITS DOCUMENTATION IN 
TERMS OF THEIRCORRECTNESS, ACCURACY, 
RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY QUALCOMM OR 
ITSAUTHORIZED REPRESENTATIVE SHALL CREATE A 



WARRANTY OR IN ANY 

WAY INCREASE THE SCOPE OF THIS WARRANTY. 
SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES, SO 
THEABOVE EXCLUSION MAY NOT APPLY.

9. Limitation of Liability. TO THE MAXIMUM EXTENT 
PERMITTED UNDER APPLICABLE LAWS, UNDER NO 
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL 
QUALCOMM, ITS AFFILIATES OR THEIR DIRECTORS, 
OFFICERS, EMPLOYEES OR AGENTS BE LIABLE FOR 
ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES (INCLUDING DAMAGES FOR LOSS OF 
BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION AND THE LIKE) 
ARISING OUT OF THE USE OR INABILITY TOUSE THE 
SOFTWARE OR ITS DOCUMENTATION, EVEN IF 
QUALCOMM OR ITS AUTHORIZED REPRESENTATIVE 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. SOME JURISDICTIONS DO NOT ALLOW 
THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE 
ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY.In 
no event shall QUALCOMM’s total liability to Licensee for 
all damages, losses, and causes of action (whether in 
contract, tort, including negligence, or otherwise) exceed 
the amount paid by Licensee for the Software and its 
documentation.

10. No Waiver or Assignment. No delay or failure to take 
action under this License will constitute a waiver unless 
expressly waived in writing, signed by a duly authorized 
representative of QUALCOMM, and no single waiver will 
constitute a continuing or subsequent waiver. This License 
may not be assigned, sublicensed or otherwise transferred 
by Licensee, by operation of law or otherwise, without 
QUALCOMM’s prior written consent, provided that 
Licensee may assign this License upon written notice to 
QUALCOMM in instances in which such assignment is to 
an entity which acquires all or substantially all of the 
business of Licensee, whether by merger, consolidation, 
or acquisition of assets.
11. Controlling Law and Severability. This License shall be 
governed by and construed in accordance with the laws of 
the United States and the State of California, as applied to 
agreements entered into and to be performed entirely 
within California between California residents. If for any 
reason a court of competent jurisdiction finds any 
provision of this License, or portion thereof, to be 
unenforceable, that provision of the License shall be 
enforced to the maximum extent permissible so as to 
effect the intent of the parties, and the remainder of this 
License shall continue in full force and effect.

12. Entire Agreement. This License constitutes the entire 
agreement between the parties with respect to the use of 
the Software and its documentation, and supersedes all 
prior or contemporaneous understandings or agreements, 
written or oral, regarding such subject matter. There shall 
be no contract for purchase or sale of the Software except 
upon the terms and conditions specified herein. Any 
additional or different terms or conditions proposed by 
Licensee or contained in any purchase order are hereby 
rejected and shall be of no force and effect unless 
expressly agreed to in writing by QUALCOMM. No 
amendment to or modification of this License will be 
binding unless in writing and signed by a duly authorized 
representative of QUALCOMM.
iv
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Introduction
Eudora Planner is a schedule and contact management tool for Windows 95®, 
Windows NT®, and Mac® OS that provides flexible portability and simple data 
sharing in a package that is easy to learn and quick to use. 

Eudora Group Planner is the multi-user version of Eudora Planner. Workgroups that 
use Eudora Group Planner can selectively share calendars, contacts and to-do lists 
over a TCP/IP network. Group scheduling makes it easy to schedule people, rooms, 
and resources while avoiding the scheduling conflicts that can so often occur. With 
support for required or optional attendance, Eudora Group Planner automatically 
displays a list of available meeting times and indicates potential schedule conflicts. It 
automatically notifies invitees of new meetings or schedule changes, and indicates 
which users have accepted or declined.

About This Guide
This guide describes how to plan, set up, and maintain a multi-user, networked 
Eudora Group Planner installation using both Power Macintosh® computers and 
PCs running Windows 95 or Windows NT.

How to Use This Guide
This guide can help you set up a Eudora Group Planner workgroup installation that 
suits the needs of your organization. Its goal is to help you consider all factors 
involved in planning the installation, and then guide you through the steps involved 
in setting it up. It can also aid you in modifying and maintaining your Eudora Group 
Planner workgroup as the personnel and requirements of your organization change.

To install and maintain Eudora Group Planner, you should be familiar with TCP/IP, 
your network topology, with the Windows 95 or Windows NT operating system from 
Microsoft® or Mac OS operating system from Apple®, and with the business 
functions and security considerations governing the users who will be accessing 



information from Eudora Group Planner.

The procedures in this guide assume that you are familiar with Windows 95 or 
Windows NT or with Mac OS System 7.6.1 or later. If you’re new to the operating 
environment you’re using, please refer to the appropriate user’s guide for more 
information.

Conventions Used in the Guide
This guide calls attention to certain kinds of information with the following symbols:

Used as a note to provide additional information or to ensure that you avoid 
problems.

Used as a tip to describe a noteworthy feature.

Used to indicate that you can right-click an item in Windows to see a shortcut menu 
that contains commands you can use on the item.

Used to indicate that you can control-click an item on the Macintosh to see a 
contextual menu that contains commands you can use on the item.
viii



Chapter 1

Planning your Eudora Group
Planner Installation

There are many factors to consider before you install Eudora Group Planner 
throughout your network. This chapter familiarizes you with these issues to prepare 
you for the task at hand.

System Requirements for a Eudora Group Planner Server
Any Windows 95, Windows NT 4.0, or Power Macintosh computer that can run 
Eudora Planner can host a Eudora Group Planner server. The only additional 
requirement is that the computer hosting the Eudora Group Planner server must 
have a static Internet Protocol (IP) address assigned.

Windows PC Requirements
More specifically, to install and use a Eudora Group Planner server on a PC, you 
need

• A personal computer with a 486 or higher processor (Pentium 90 
recommended).

• The Microsoft Windows 95 operating system or Windows NT® workstation 
operating system version 4.0 or later. For Windows NT 4.0 installations, Service 
Pack 3 for Microsoft Windows NT is also required.

• 16 MB of RAM for use on Windows 95 and Windows NT Workstation 4.0.

• 18 MB of hard disk space.

• A CD-ROM drive.

• A VGA or higher-resolution video adapter (SVGA 256-color with 800x600 or 
Planning your Eudora Group Planner Installation 1



higher resolution recommended).

• A Microsoft Mouse or compatible pointing device.

• A static IP address.

Macintosh Requirements
To install and use a Eudora Group Planner server on a Macintosh, you need

• A Power Macintosh or equivalent
• Mac® OS System 7.6.1 or later
• Open Transport 1.1 or later
• 16 MB of RAM
• 25 MB of hard disk space
• A CD-ROM drive
• A static IP address

About Eudora Group Planner Servers
Every installation of Eudora Planner has a Eudora Planner server running as its 
core element. This Eudora Planner server manages the Event and Contact data for 
the application. In each Eudora Planner installation, this server functions as one of 
two types: local or workgroup.

On most end user’s computers, the Eudora Planner server is a local server—a 
stand-alone server that manages those Contacts and Events that reside in the 
user’s local, personal Eudora Planner database. Other Eudora Planner users 
cannot connect to this local server or view data in the local database.

Each local Eudora Planner server has the potential to connect to—and integrate 
with—remote, workgroup Eudora Planner servers via TCP/IP.

If you want to have your users share Eudora Planner data using Eudora Group 
Planner, you must install a workgroup server on at least one computer on your 
network. The workgroup server acts as the hub in a wheel of users, connecting all to 
a central, shared database of public Contacts, Events, and categories. You can 
install multiple workgroup servers, depending on your needs. You can also install 
workgroup servers on desktop computers—a dedicated file server is not required; 
any Windows 95, Windows NT 4.0, or Power Macintosh computer that can run 
Eudora Planner can host a Eudora Group Planner server.

For group scheduling to work effectively, it is important for each user to specify a 
home server. The home server tracks all Events a user is attending, has declined, or 
has been invited to, as well as the general hours of availability defined for them, and 
makes this information available to other users. Each user must specify a home 
server, even if there is only a single shared, workgroup server. Normally, all users 
should make the workgroup server their home server.
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You must create user accounts on the workgroup server before it can be used for 
group scheduling. Users will not be able to log in to a workgroup server unless there 
is an account created there for them.

Planning Your Server Setup
This section describes your options in choosing a server arrangement to suit your 
workgroup.

All Eudora Group Planner servers must be assigned a permanent, static IP address.

Server Scenarios
The number of users that will be using Eudora Planner, and the ways that they are 
organized, will help you determine the best server setup for your workgroup. There 
are three major types of workgroup server arrangements:

• Single, dedicated workgroup server
• Multiple, dedicated workgroup servers
• Workgroup server residing on a user’s computer

The following sections discuss these possible configurations, and list the benefits 
and limitations of each one.

Single, Dedicated Workgroup Server
In this arrangement, all Eudora Group Planner users share Events and Contact 
information through a single workgroup server. This is the simplest and easiest-to-
manage solution, and the one most suited to the needs of most Eudora Planner 
workgroups.

By placing the Eudora Group Planner server on a dedicated network file server, you 
can be sure that it is provided as stable an operating environment as your other 
network applications. The advantages of the centralized, dedicated server are that it 
is easier to manage, more secure, and can generally provide better performance in 
a workgroup.

Tim Susan

Wendy

Workgroup Server
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The main disadvantage of this arangement is that it does require a dedicated 
machine. If you are in a small orginization that doesn’t have a dedicated file server 
computer, you may prefer the arrangement described in “Workgroup Server on a 
User’s Computer” on page 5.

Multiple Dedicated Workgroup Servers
If you are in a larger organization, or have more complex organizational or security 
needs, your Eudora Group Planner may be more suited to an arrangement using 
multiple workgroup servers. 

The size, organization, and security requirements of your organization will 
determine how many servers you require.

Additional workgroup servers can help spread a large amount of Event and Contact 
data over more computer processing power, resulting in faster performance for 
Eudora Group Planner in general. It also can provide better security, as sensitive 
data can be separated off onto computers to which only specific users can access—
with the added benefit that the data so separated resides only on the server 
resources already dedicated to that group of users.

Of course, with the added complexity of such an arrangement comes trade-offs 
such as increased difficulty in finding particular information.

Tim

Susan

Wendy

Workgroup Server 1
(Sales)

Howard

Robert

Workgroup Server 2
(Accounting)
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Workgroup Server on a User’s Computer
For small workgroups in which a dedicated Eudora Group Planner server is not 
feasible, schedule and contact sharing is still possible by installing the workgroup 
server on a user’s desktop computer.

In this scenario, the the computer that hosts the Eudora Group Planner server is still 
available full-time for performing other computing tasks.

Planning Eudora Planner Security
As administrator for the Eudora Planner workgroup, it is your responsibility to set up 
and maintain the security of the Eudora Planner data being accessed. Eudora 
Planner has a powerful, flexible set of access permissions designed to let you 
provide the right information to the right users.

Access permissions created on a Eudora Planner server affect only those Events, 
Contacts, and categories residing on that server. If you are installing multiple 
workgroup servers in your organization, you must set up access permissions for all 
users on each server, regardless of whether those users have had permissions 
assigned to them on other servers.

There are two categories of access permissions in Eudora Planner: privacy and 
security. The category that most concerns you as administrator is security. However, 
because it is something you should be aware of, you should also understand the 
privacy permissions as well.

Privacy Permissions
Privacy permissions apply to individual Events and Contacts, and determine 
whether an Event or Contact created by a particular user can be modified or deleted 
by another. They provide a method by which users can allow or prevent others from 
viewing or changing the Events and Contacts they create. Eudora Planner allows 
users to define unique privacy permissions for each Event and Contact they create, 
provided that you enable this ability by granting them the security permission of 

Tim Susan

Wendy

Robert 
(Workgroup 
Server)
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“change privacy.” You can define default privacy settings for the new Events and 
Contacts that each individual user creates, or you can let your users set these 
defaults themselves. 

Instructions for changing privacy permissions are discussed in the Eudora Planner 
User’s Guide.

There are five different types of privacy permissions:

Security Permissions
Like privacy permissions, security permissions affect groups of users as well as 
individuals. They govern each user’s ability to do routine tasks, like creating, 
deleting, and modifying Events and Contacts, or more complex operations, like 
administering some aspects of the workgroup server’s user and groups 
configuration.

As the Eudora Planner administrator, you can grant or deny any or all of seven 
different types of permissions.

Permission Type When granted, lets other users...

Delete Delete this Event or Contact.

Modify Add, change or delete information—such as titles, notes, and 
attachments—contained in this Event or Contact.

Modify Access Change the permissions for this Event or Contact. For example, if 
you assigned someone else Modify Access permission for this 
Event or Contact, they could in turn change the access 
permissions of this Event or Contact in regard to other users.

Read View this Event or Contact (the default).

Take Ownership Take possession of this Event or Contact, if necessary.

Permission Type When granted, lets the user...

Create/Modify 
Contacts and Events

Add, change or delete information contained in an item stored on 
the server. For example, a user with Modify permission can add 
a note to a public Contact or change the title of a public Event. 
However, Modify permission does not allow a user to delete an 
item.

Delete Contacts and 
Events

Delete Contacts and Events on the server.

Change privacy for 
Contacts and Events

Grant other Eudora Planner users permissions for this user’s 
Events and Contacts.

Create/Modify 
categories and 
custom fields

Add or change categories and custom fields stored on the 
server.
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Because they can be assigned to both users and groups, security permissions can 
be set in multiple places for a single user. When this happens, any particular 
permission that is turned off, or disabled, overrides other settings for the same 
permission that is turned on, or enabled. For example, imagine that a user, Judy, is 
assigned to a user group called Sales. As manager of the sales department she is 
granted all possible permissions at the user level. However, because other users in 
the Sales group are not at her level, the permissions to manage users and groups 
and to take ownership of Contacts and Events are not enabled for that group. In this 
case, because she belongs to a group that does not have these two permissions, 
she does not have them as an individual user.

When you are logged in as the administrator, you are granted all of the security 
permissions. The remainder of this book contains procedures that can only be 
performed by someone having the appropriate permissions. In these instances, it is 
assumed that you are logged in as the administrator.

For directions on setting security permissions on Windows 95 and Windows NT 
servers, see “Granting Security Permissions in Windows” on page 12. For directions 
on setting security permissions on Macintosh servers, see “Granting Security 
Permissions on the Macintosh” on page 20.

Delete categories 
and custom fields

Delete categories and custom fields on the server.

Manage servers Connect to and disconnect from Eudora Planner workgroup 
servers.

Manage users and 
groups

Add users and groups to the server, as well as alter the attributes 
of existing users and groups, including their server permissions. 

Take ownership of 
Contacts and Events

Gain ownership of another user’s public Contacts and Events, so 
that Eudora Planner recognizes that the items belong to the new 
owner and not to the original owner. When a user takes 
ownership of public Contacts and Events, he or she has full 
permissions for them. Normally, only the Eudora Planner 
administrator has Take Ownership permission.

Permission Type When granted, lets the user...
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How Privacy and Security Permissions Work Together
As both security and privacy permissions have Delete and Modify permissions that 
could possibly conflict, it’s important to understand how the two types of 
permissions interact.

Eudora Planner permissions define the potential actions of a user or group. For 
example, if Joe has the Delete security permission, he may be able to delete Events 
and Contacts on the workgroup server—that is, he can delete any Event or Contact 
that has a privacy permission that allows him to delete it. If he does not have Delete 
permission, then he is never allowed to delete Events and Contacts.

The following table illustrates the relationship between the privacy and security 
permissions for Delete and Modify.

Server Security Permissions

Yes No

Privacy Yes Allowed Not allowed

Permissions No Not allowed Not allowed



Chapter 2

Configuring a Eudora Group
Planner Server for Windows

This chapter describes the steps involved in setting up a workgroup server on a 
computer running Windows 95 or Windows NT. It explains how to:

• Install and set up a Eudora Group Planner server
• Define users and groups of users on the server
• Grant access rights to those users and groups
• Create workgroup categories
• Manage data on the server remotely

Installing the Eudora Group Planner Server
Installation of Eudora Planner server for Windows is the same whether you are 
installing a personal or workgroup server. The only difference is in the installation 
software you use.

To install a Eudora Group Planner server:
1. Insert the CD-ROM.

2. From the Start menu, select Run.

3. Type D:\GPlanner\Setup.exe

where D represents your CD-ROM drive’s volume.

The Eudora Planner installation program launches.

4. Follow the instructions provided by the installer to complete the installation.

By default, the Eudora Planner installation program assigns the host computer’s 
Windows name as the name of the Eudora Planner server. If this name is not likely 
to be recognizable to your users, then you should change it to a name that will be 
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more obvious to them. To do this, select Servers from Eudora Planner’s Tools 
menu. In the Servers dialog box that appears, right-click on the server’s default 
name and select Properties from the pop-up menu that appears. The Server 
Properties dialog box appears, in which you can type a new name for the server.

Configuring Users and Groups
Before your Eudora Group Planner users can log in to the workgroup server, you 
must create a user account for each user. Additionally, you can create groups on the 
workgroup server to better manage large numbers of users.

Creating User Accounts
At minimum, a user account consists of a user’s name and the set of permissions 
granted to that user. If necessary, you can also add contact information, such as a 
user’s physical address, email address, and phone number, to a user account. You 
can also assign the user to groups, which are described in “Creating and Populating 
Security Groups” on page 11, or set up proxies for the user, as explained in 
“Assigning User Proxies” on page 13.

To create a user account on a workgroup server:
1. From the Tools menu, choose Users and Groups. 

The Users and Groups dialog box appears.

2. From the drop-down Server list, select the name of the workgroup server.

3. Click New User. 

The User Properties dialog box appears.

4. Specify a user name in the User Name box. Then, specify other, optional 
information as necessary:

• On the General tab, type in Contact information for this new user.

• On the Groups tab, select the security groups that this user will belong to. 
See “Creating and Populating Security Groups” on page 11 for information.

• On the Password tab, type a password, then type it again to confirm it.

• On the Privacy tab, define the privacy settings for this user. For information 
on these privacy settings, see “Granting Security Permissions in Windows” on 
page 12.

• On the Advanced tab, select a home server for this user. Then, click the 
Security and Proxies buttons to define access permissions and proxies for this 
user. For information on security and proxy settings, see “Granting Security 
Permissions in Windows” on page 12.

5. When you've finished setting up this user in the User Properties dialog box, 
click OK to return to the Users and Groups dialog box.
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6. Repeat steps 3 through 5 to add additional users.

7. Click OK when you’re finished.

Importing Users
If you need to set up a lot of users, you can import a list of users from a text file using 
the Import button on the Users and Groups dialog box. This text file must have the 
following format:

firstname lastname
firstname lastname
firstname lastname
...

You can also import users from those registered in Windows.

To import users in a text file:
1. From the Tools menu, choose Users and Groups.

The Users and Groups dialog box appears.

2. From the drop-down Server list, select the server for which you want to create 
users.

3. Click Import.

The Import Users dialog box appears.

4. Select the type of import you want to perform. 

• To import users from Windows, click the My Computer option. 
• To import users from a text file, click the Text file option, then type a file name 

or click the Browse button to locate the text file using an Open dialog box.

5. Click OK to import the names.

Creating and Populating Security Groups
As the scale of your Eudora Group Planner user base expands, you may find that 
you can most efficiently manage users’ permissions through the use of groups. A 
group is a subset of Eudora Group Planner users that share the same permissions 
for the workgroup server. When you assign a user to a group, the user acquires that 
group’s workgroup server permissions (except in cases where you have individually 
denied the user a permission granted to the group, a scenario described in “Security 
Permissions” on page 6). Depending on the structure of your organization, you 
might create groups that correspond to departmental divisions, employee hierarchy, 
or even computer savvy amongst users.

To add a security group to a workgroup server:
1. From the Tools menu, choose Users and Groups. 

The Users and Groups dialog box appears.
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2. From the drop-down Server list, select the server for which you want to create 
groups.

3. Click New Group. 

The Group Properties dialog box appears.

4. Specify a group name in the Group Name box. Then, specify other, optional 
information as necessary:

• In the Group Name box, type a name for this group.

• On the Users tab, add any existing users that you want to belong to this 
group.

• On the Advanced tab, click the Security button to define access permissions 
for this group. For information on how group security settings affect individual 
user’s security settings, see “Granting Security Permissions in Windows” on 
page 12.

5. When you've finished setting up this group in the Group Properties dialog box, 
click OK to return to the Users and Groups dialog box.

6. Repeat steps 3 through 5 to add additional groups.

7. Click OK when you're finished.

The security groups you’ve created are saved to the Eudora Group Planner 
server. The permissions granted to the groups now apply to any users assigned 
to those groups.

Granting Security Permissions in Windows
Granting security permissions among your Eudora Group Planner users is a step 
that requires a little planning and consideration. Your organization, and the various 
roles of people in it, should suggest a logical scheme. Discussing the needs of key 
people in your organization may be helpful towards creating a scheme of 
permissions that is secure, yet flexible. See “Security Permissions” on page 6 for 
more information on security permissions.

To assign or change access permissions:
1. From the Tools menu, select Users and Groups.

The Users and Groups dialog box appears.

2. From the drop-down Server list, select the server for which you want to define 
permissions.

3. In the Users and Groups area, click the plus sign next to Users.

A list of the users residing on the server appears.

4. Select a user’s name, then click Details.

The User Properties dialog box appears. 
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5. Select the Advanced tab, then click the Security button.

The Security dialog box appears, displaying the permissions assigned for this 
user.

6. Select the permissions appropriate to this user, then click OK to close the 
Security dialog box.

7. Repeat steps 4 through 6 to grant permissions to other users.

Assigning User Proxies
In Eudora Group Planner, a proxy is a user that can act on behalf of another user, 
whether in the creation of shared Events and Contacts or by handling items related 
to group scheduling. To demonstrate the benefits of Eudora Group Planner’s proxy 
feature, we’ll use the fictitious situation of Katrina, a sales manager, and Valerie, her 
administrative assistant. 

As Katrina’s assistant, Valerie is responsible for maintaining Katrina’s Eudora Group 
Planner Calendar and Address Book. Katrina therefore designates Valerie as her 
proxy, which enables Valerie to log in with Katrina’s user name. Once she has 
logged in as Katrina, Valerie can view all of Katrina’s workgroup Events and 
Contacts, as well as create new workgroup Events and Contacts that show Katrina 
as the last modifier. Valerie can also accept and decline meeting invitations on 
Katrina’s behalf. Valerie cannot, however, see Katrina’s local Events and Contacts. 

As the workgroup server administrator, you can assign proxies to any users in the 
Eudora Group Planner workgroup. The users themselves can also add proxies to 
their own user accounts

To assign a proxy to a user:
1. From the Tools menu, select Users and Groups.

The Users and Groups dialog box appears.

2. Use the Server drop-down list to select the server for which you want to set a 
proxy.

3. In the Users and Groups list, select the user for whom you want to assign a 
proxy, then click the Details button.

The User Properties dialog box appears.

4. Click the Proxies tab.

5. In the All users list, click the user that you want to assign as a proxy, then click 
the Add button to place that user in the Proxy users list. Repeat this step as 
necessary if you want to add additional proxies.

6. Click OK to close the User Properties dialog box.

7. Click OK again to close the Users and Groups dialog box.

The user you selected to be proxy is now able to log in as the user selected in 
step 3.
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Creating Categories for the Workgroup Server
Each Eudora Group Planner server is installed with several predefined categories 
for use in grouping related Events and Contacts. Still, if there are special needs in 
your organization for additional categories—for example, ones specific to clients, 
projects, or other elements of your business—now is a good time to create them.

See Chapter 4 of the Eudora Planner User’s Guide for more information on 
categories and general organization in Eudora Planner.

To create a category:
1. From the Tools menu, select Categories.

The Categories dialog box appears. Available categories appear in a list.

2. Click New.

The Category Properties dialog box appears.

3. In the Name box, type a name for the category.

While you can assign Font and Background Color settings to give the 
category a distinctive appearance, doing so will affect the way the 
category appears only on the server computer. Users connected to the 
server remotely will see the category according to how it is set to appear 
on their computers..

4. Click OK.

Eudora Planner adds the category to the Categories list.

Creating Custom Fields for the Workgroup Server
The Eudora Group Planner workgroup server comes installed with number of 
Address Book custom fields, but you can create additional custom fields to make 
available for your users. The custom fields you create on a workgroup server can be 
assigned only to the Contacts residing on that server. They are not available in the 
Custom Fields area of Contacts residing in users’ local databases. For more 
information about custom fields, see Chapter 3 of the Eudora Planner User’s Guide

To create a custom field for the workgroup server:
1. From the Tools menu, select Custom Fields. 

The Custom Fields dialog box appears.

2. Click the arrow in the Server box.

A drop-down list of available servers appears.

3. From the drop-down list, select the server to which you want to add the custom 
field.

4. Click New.
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The Custom Field Properties dialog box appears.

5. Type a name for the Custom Field in the Name box.

6. Select a field type for the Custom Field. For information about field types, see 
Chapter 3 of the Eudora Planner User’s Guide.

7. Click OK to close the Custom Field Properties dialog box, then click OK to close 
the Custom Fields dialog box.

The custom field is saved to the workgroup server and appears in any Contact 
stored on that server.
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Chapter 3

Configuring a Eudora Group
Planner Server for Macintosh

This chapter describes the steps involved in setting up a workgroup server on a 
Macintosh computer. It explains how to:

• Install and set up a Eudora Group Planner server
• Define users and groups of users on the server
• Grant access rights to those users and groups
• Create workgroup categories
• Remotely manage data on the server 
• Import existing data sources onto the server

If you are upgrading to Eudora Group Planner from Now Up-toDate and Contact 
version 3.6.5, be sure to read te sections on upgrading at the end of this chapter.

Installing the Eudora Group Planner Server
The procedure for installing Eudora Group Planner is the same whether you are 
installing a client or workgroup server; the only difference is in the installation 
software you use.

To install a Eudora Group Planner server:
1. Insert the CD-ROM.

2. Double-click the Eudora Group Planner Server Installer.

3. Select an installation option, then click Install.

4. Choose a destination folder for installation, then click Install.

The Eudora Group Planner server is installed at the destination you’ve 
specified.
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Configuring Users and Groups
Before your Eudora Group Planner users can log in to the workgroup server, you 
must create a user account for each user. Additionally, you can create groups on the 
workgroup server to better manage large numbers of users.

Creating User Accounts
At minimum, a user account consists of a user’s name and the set of permissions 
granted to that user. If necessary, you can also add contact information, such as a 
user’s physical address, email address, and phone number, to a user account. You 
can also assign the user to groups, which are described in “Creating and Populating 
Security Groups” on page 19, or set up proxies for the user, as explained in 
“Assigning User Proxies” on page 20.

To create a user account on a workgroup server:
1. From the Define menu, select Users and Groups. 

The Users and Groups dialog box appears.

2. From the Servers pop-up menu, select the name of the workgroup server, if it 
does not already appear.

3. In the User Name area, click New.

The Edit User dialog box appears, displaying the Contact tab.

4. Type a user name in the Name boxes, then enter other, optional information as 
necessary:

• On the Contact tab, type in contact information for this new user. If this 
information can be found in an existing Contact, it will be filled in 
automatically.

• On the Groups tab, select the security groups that this user will belong to. 
See “Creating and Populating Security Groups” on page 19 for information.

• On the Password tab, specify, and confirm, a password for the user. This is 
necessary only if, on the Rights tab, you specify that the user must enter a 
password before logging in.

• On the Rights tab, select the appropriate server permissions for this user. 
Also, specify whether the user must enter a password before logging in to the 
server. By default, new users are granted permission to access a remote 
server if their user license permits it.

• On the Privacy tab, define the privacy settings for this user. For information 
on these privacy settings, see “Granting Security Permissions on the 
Macintosh” on page 20.

• On the Proxies tab, define any proxies needed by this user. For information 
on proxy settings, see “Assigning User Proxies” on page 20.
18



5. When you’ve finished setting up this user account in the User Properties dialog 
box, click OK to return to the Users and Groups dialog box.

6. Repeat steps 3 through 5 to add additional users.

7. When you’ve finished adding users, click OK.

The user accounts and related settings are saved to the workgroup server. Also, 
a Contact is added to the server’s Address Book listing for this user, if one did 
not exist already.

The Eudora Group Planner users you added are now able to log in to the server 
with user names you created. You can change the user information you’ve 
entered here at any time.

Creating and Populating Security Groups
As the scale of your Eudora Group Planner user base expands, you may find that 
you can most efficiently manage users’ permissions through the use of groups. A 
group is a subset of Eudora Group Planner users that share the same permissions 
for the workgroup server. When you assign a user to a group, the user acquires that 
group’s workgroup server permissions (except in cases where you have individually 
denied the user a permission granted to the group, a scenario described in “Security 
Permissions” on page 6). Depending on the structure of your organization, you 
might create groups that correspond to departmental divisions, employee hierarchy, 
or even computer savvy amongst users.

To add a security group to a workgroup server:
1. From the Define menu, select Users and Groups.

The Users and Groups dialog box appears.

2. From the Servers pop-up menu, select the server for which you want to create 
group.

3. In the Group Name area of the dialog box, click New.

The Edit Group dialog box appears.

4. Enter a group name in the Group Name box. Then, specify other information as 
necessary:

• On the Users tab, select a user name, then click Add to assign that user to 
this group.

• On the Rights tab, select options to define the security permission for the 
group. For information on how group security settings affect individual user’s 
security settings, see “Granting Security Permissions on the Macintosh” on 
page 20.

5. When you've finished setting up this group in the Edit Group dialog box, click 
OK to return to the Users and Groups dialog box.

6. Repeat steps 3 through 5 to add additional groups.
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7. Click OK when you’ve finished.

The security groups you’ve created are saved to the Eudora Group Planner 
server. The permissions granted to the groups now apply to any users assigned 
to those groups.

Granting Security Permissions on the Macintosh
Granting security permissions among your Eudora Group Planner users is a step 
that requires a little planning and consideration. Your organization, and the various 
roles of people in it, should suggest a logical scheme. Determining the needs of key 
people in your organization may be helpful towards creating a scheme of 
permissions that is secure, yet flexible. See “Security Permissions” on page 6 for 
more information on security permissions.

To assign or change access permissions:
1. From the Define menu, select Users and Groups.

The Users and Groups dialog box appears.

2. From the Servers pop-up menu, select the server for which you want to define 
permissions.

A list of the users residing on the server appears.

3. Select a user’s name, then click Edit.

The Edit User dialog box appears. 

4. Select the Rights tab.

5. Select the permissions appropriate to this user, then click Done to close the 
Edit User dialog box.

6. Repeat steps 3 through 5 to grant permissions to other users.

Assigning User Proxies
In Eudora Group Planner, a proxy is a user that can act on behalf of another user, 
whether in the creation of shared Events and Contacts or by handling items related 
to group scheduling. To demonstrate the benefits of Eudora Group Planner’s proxy 
feature, we’ll use the fictitious situation of Katrina, a sales manager, and Valerie, her 
administrative assistant. 

As Katrina’s assistant, Valerie is responsible for maintaining Katrina’s Eudora Group 
Planner Calendar and Address Book. Katrina therefore designates Valerie as her 
proxy, which enables Valerie to log in with Katrina’s user name. Once she has 
logged in as Katrina, Valerie can view all of Katrina’s workgroup Events and 
Contacts, as well as create new workgroup Events and Contacts that show Katrina 
as the last modifier. Valerie can also accept and decline meeting invitations on 
Katrina’s behalf. Valerie cannot, however, see any Events and Contacts on Katrina’s 
computer that are not shared.

As the workgroup server administrator, you can assign proxies to any users in the 
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Eudora Group Planner workgroup. The users themselves can also add proxies to 
their own user accounts

To assign a proxy to a user:
1. From the Define menu, select Users and Groups.

The Users and Groups dialog box appears.

2. In the User Name area, select the name of the user to whom you want to 
assign a proxy (the proxied user), then click Edit.

The Edit User dialog box appears.

3. Click the Proxies tab to make it the active tab.

4. In the Not Proxies list, select the user that you want to act as the proxy. Then, 
click Add. 

The selected user’s name is added to the Proxies list.

5. Click Done to return to the Users and Groups dialog box. Then, click Done 
again to close this dialog box.

The user you selected to be proxy is now able to log in as the user selected in 
step 2.

Creating Categories for the Workgroup Server
Each Eudora Group Planner server is installed with several predefined categories 
for use in grouping related Events and Contacts. If there are special needs in your 
organization for additional categories—for example, ones specific to clients, 
projects, or other elements of your business—now is a good time to create them.

See Chapter 4 of the Eudora Planner User’s Guide for more information on 
categories and general organization in Eudora Group Planner.

To create a category:
1. From the Define menu, select Categories.

The Edit Categories dialog box appears. Available servers and their respective 
categories appear in a list.

2. In the Available Categories list, select the server to which you want to add the 
category. Then, click New. 

The Category dialog box appears.

3. In the Name box, type a name for the category. 

4. To give the category a distinctive appearance, select a font by clicking the Font 
pop-up menu. Specify the font size and color in the Size and Color boxes and 
then choose a font style by selecting a check box. Select a Justify option. 
When you finish, click OK. The settings you select here will only affect Events or 
Contacts having this category as their primary category (see the Eudora 
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Planner User’s Guide for information about primary categories).

5. Click OK.

Eudora Group Planner adds the category to the Available Categories list. This 
category is available to any user logged in to the workgroup server.

Creating Custom Fields for the Workgroup Server
The Eudora Group Planner workgroup server comes installed with number of 
Address Book custom fields, but you can create additional custom fields to make 
available for your users. The custom fields you create on a workgroup server can be 
assigned only to the Contacts residing on that server. They are not available in the 
Custom Fields area of Contacts residing in users’ local databases. For more 
information about custom fields, see Chapter 3 of the Eudora Planner User’s Guide

To create a custom field for the workgroup server:
1. From the Define menu, select Custom Fields. 

The Custom Fields dialog box appears.

2. Select a server from the Servers pop-up menu.

3. Click New.

The Custom Field dialog box appears.

4. Enter a name for the Custom Field in the Name box.

5. Click the Type pop-up menu to select a field type for the custom field. For 
information about field types, see Chapter 3 of the Eudora Planner User’s 
Guide.

6. Click OK to close the Custom Field dialog box, then click OK to close the 
Custom Fields dialog box.

The custom field is saved to the workgroup server and appears in the Custom 
Fields area of any Contact stored on that server.

Upgrading from Now Up-to-Date and Contact for Macintosh
This section contains important information for organizations that are migrating from 
Now Up-to-Date and Contact versions 3.6.5 for Macintosh to Eudora Group 
Planner. If your organization currently uses Now Up-to-Date and Contact 3.6.5 to 
share Events and Contacts over a network, you should read this section thoroughly 
before beginning to migrate to Eudora Planner.

A Now Up-to-Date server contains information necessary for group scheduling, 
such as user login names and records of users’ blocked time. The instructions 
contained here explain how to import your Up-to-Date server while preserving that 
data for Eudora Planner. By following these instructions, you will save time in 
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entering user names and enable your users to immediately start using Eudora 
Planner for group scheduling—just as they did Up-to-Date.  

Before you begin to migrate, you should know what information Eudora Planner 
actually imports from Now Up-to-Date and Contact.

What Transfers from a Now Up-to-Date File
Eudora Planner's Up-to-Date import feature imports the following:

• All standard Event fields, such as Title, Start Date, Start Time, and Duration
• All Event Categories
• Information in the Description area
• Records of users' blocked time
• All user names (Public Event Server only)

The following are not imported:

• Priority settings
• Attachment information

What Transfers from a Now Contact File
Eudora Planner imports the following data from Now Contact:   

• Every Contact field, including the custom fields.  Because Eudora Planner 
supports an unlimited number of custom fields, even custom field titles are 
transferred.      

• Although the primary Email field is a custom field in Contact, it is mapped to 
Eudora Planner’s standard Email field during importation.  Any secondary Email 
fields in Contact  are mapped to Eudora Planner's custom fields.

• Comments, Notes, and QuickContact designation.  The QuickContact 
designation also appears as a Category.

• Keywords transfer as Categories.

Eudora Planner does not import any attachment information

Migrating from Now Up-to-Date for Macintosh
Migrating from Now Up-to-Date to Eudora Group Planner entails more than just 
importing Public Event Server data into the Eudora Group Planner workgroup server 
and then letting users connect to the new server. An Up-to-Date server contains 
important information necessary for group scheduling, such as user login names 
and records of users’ blocked time. Because of factors related to this, you must 
follow a step-by-step procedure that requires you to coordinate migration of the 
server data with that of the data in each user’s Up-to-Date database.

The instructions for upgrading from Now Up-to-Date for Macintosh must be followed 
exactly as described here. Any variation on this procedure can result in duplication 
of data and the loss of users’ time blocks and reminders.
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To upgrade a workgroup from Now Up-to-Date for Macintosh:
1. Open the Eudora Group Planner server. From the File menu, select Import, 

then select Public Event Database from the submenu that appears.

The Open dialog box appears.

2. Navigate to find the Now Up-to-Date for Macintosh server database that you 
want to import, select it, then click Open.

The database is imported into the Eudora Group Planner server. The import 
transfers all Events, category names, user names, and resources stored in the 
databases, and preserves reminders for Public Events and user’s time block 
information.

3. Have the Eudora Planner users connect to the workgroup server, log in with 
their user names, and set the workgroup server as their home server as 
described in “Giving Users Access to the Workgroup Server” on page 29.

4. Have each user import his or her own Now Up-to-Date database into the 
Eudora Planner client. 

The import brings in only local Events stored in Now Up-to-Date, preserving 
any reminders and time blocks associated with those Events. Public Events are 
not transferred during this import; Public Events are transferred when you 
import the Public Event database.

Importing Data from a Now Contact Server
Most Contact data is transferred, including all standard field data, category names, 
notes, and custom field names. Keywords are imported as Eudora Planner 
categories.

To import data from a Now Contact server:
1. From the File menu, select Import, then select Public Contact Database from 

the submenu that appears.

The Open dialog box appears.

2. Navigate to find the Now Contact server database you want to import, select it, 
then click Open.

A progress bar appears, indicating the status of the import. Once the import is 
complete, Contact information appears in the Address Book. All Contact 
information is imported, except for attached Events, documents, and aliases.
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Importing Data from a Now Up-to-Date or Contact Client File
When you import from an Now Up-to-Date or Contact client file, only Private data is 
transferred.

To import from Now Up-to-Date and Contact:
1. From the File menu, select Import.  Then, from the resulting submenu, select 

either Now Up-to-Date Database or Now Contact Database. 

The Open dialog box appears.

2. Navigate to find the Now Up-to-Date or Now Contact database you want to 
import, then select it.

3. Click Open.  

A progress bar appears, indicating that Eudora Planner is importing data from 
the selected database.  Once the import is complete, the data appears in 
Eudora Planner.
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Chapter 4

Setting Up Eudora Planner for
Windows Users

This chapter describes the steps involved in setting up each Windows user to 
access the workgroup server:

• Installing the Eudora Planner client
• Setting up users to access the workgroup server
• Setting the server update frequency

Installing Eudora Planner 
Installation of Eudora Planner for Windows is the same whether you are installing a 
personal or workgroup server. The only difference is in the installation software you 
use.

To install a Eudora Planner client:
1. Insert the CD-ROM. The Eudora Planner installation program appears.

2. Click the Install Eudora Planner 4.0 button. The installation begins. 

3. Follow the instructions provided by the installer to complete the installation.

Giving Users Access to the Workgroup Server
After you’ve set up the workgroup server, those users for whom you’ve created user 
accounts can connect to it, make it their home server, and begin sharing scheduling 
and contact information.

To connect to a workgroup server, each user must know either the IP address, 
fully-qualified domain name, or Windows’ computer name for the server.
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Have each user do the following to connect to a Eudora Group Planner server:
1. From the Tools menu, select Servers.

The Servers dialog box appears.

2. In the Servers dialog box, double-click Add Server.

The Server Wizard appears.

3. Follow the Server Wizard as it guides them through the server connection 
process.

After users have logged in to a workgroup server, they can begin sharing Events 
and Contacts with other users. However, to take full advantage of group 
scheduling—to get meeting invitations and have their available time blocked by 
Events they are attending—they must designate a workgroup server as their home 
server. The home server tracks a user’s schedule, noting which Events occupy the 
user’s time, and broadcasts the user’s availability to others who invite the user to a 
meeting. 

Have each user do the following to assign or change the home server:
1. From the Tools menu, choose Servers. 

The Servers dialog box appears.

2. Right-click on a server in the Servers list, then select home server from the 
pop-up list.

3. When the workgroup server login dialog box appears, type a user name and, if 
necessary, a password. Then, click OK.

4. Close the Servers dialog box.

Setting Server Update Preferences
Each user can set the frequency with which the Eudora Planner database on his or 
her computer receives updated Eudora Planner information from a workgroup 
server. He or she can also force an immediate update from a workgroup server.

Users can force an immediate update from all servers by clicking the Update All 
Servers button on the toolbar.

To set the server update frequency:
1. From the Tools menu, select Servers.

The Servers dialog box appears, listing all the servers to which you are 
connected.

2. Double-click the server for which you wish to change the update frequency.

The Server Properties dialog box appears.

You can right-click the icon for the server, then select Properties from the 
shortcut menu that appears.
26



3. Click the Update tab.

4. In the Update Frequency box, type the frequency, in minutes, with which your 
database receives updates from the server.

5. Click OK.

The Eudora Planner client will now receive server updates from the workgroup 
server at the specified interval.

To force an update from a specific server:
1. From the Tools menu, select Servers.

The Servers dialog box appears, listing all the servers to which this user is 
connected.

2. Double-click the server for which you wish to force the update.

The Server Properties dialog box appears.

3. Click the Update tab.

4. Click Update Now.

The server immediately updates the local Eudora Planner database with any 
changes or additions that other users have made since the last update.

You can force an update by right-clicking the server’s icon in the Servers 
dialog box, then selecting Update Now from the shortcut menu that 
appears.

Accessing Workgroup Data
A final step in the process of sharing Events and Contacts is to have each user 
subscribe to Categories of Events and Contacts that reside on the workgroup 
server. For information on these tasks, see the Eudora Planner User’s Guide.
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Chapter 5

Setting Up Eudora Planner for
Macintosh Users

This chapter describes the steps involved in setting up each Macintosh user to 
access the workgroup server, including:

• Installing the Eudora Planner client
• Setting up users to access the workgroup server
• Setting the server update frequency

Installing Eudora Planner
The procedure for installing the Eudora Planner client is the same as for installing 
the workgroup server; the only difference is in the installation software used.

To install a Eudora Planner client:
1. Insert the CD-ROM.

2. Double-click Eudora Planner installer.

3. Select an installation option, then click Install.

4. Choose a destination folder for installation, then click Install.

Eudora Planner is installed at the destination you’ve specified.

Giving Users Access to the Workgroup Server
After you’ve set up the workgroup server, those users for whom you’ve created user 
accounts can connect to it, make it their home server, and begin sharing scheduling 
and contact information.
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To connect to a workgroup server, each user must know the IP address for 
the server.

Have each user do the following to connect to the Eudora Group Planner server:
1. From the Define menu, select Servers.

The Edit Servers dialog box appears.

2. Click Add Servers.

The Internet Server Information dialog box appears.

3. Have the user enter the server’s IP address into the Internet (IP) Address box. 
In the Update Interval box, the user should enter the frequency with which he 
or she wants to receive updates from the server.

After users have logged in to a workgroup server, they can begin sharing Events 
and Contacts with other users. However, to take full advantage of group 
scheduling—to get meeting invitations and have their available time blocked by 
Events they are attending—they must designate a workgroup server as their home 
server. The home server tracks a user’s schedule, noting which Events occupy the 
user’s time, and broadcasts the user’s availability to others who invite the user to a 
meeting. 

Have each user do the following to assign or change the home server:
1. From the Define menu, choose Servers. 

The Servers dialog box appears.

2. Select a server from the list, then click Make Default.

The server you’ve selected appears in bold.

3. Click Done.

The server the user has selected is that user’s home server.

Setting Server Update Preferences
Each user can set the frequency with which the Eudora Planner database on his or 
her computer receives updated Eudora Planner information from a workgroup 
server. 

Users can force an immediate update from all servers by clicking the Update All 
Servers button on the toolbar.

To set the server update frequency:
1. From the Define menu, select Servers.

The Edit Servers dialog box appears, listing all the servers to which you are 
connected.update

2. Select the server for which you wish to change the update frequency.
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The Internet Server Information dialog box appears.

3. In the Update Interval box, type the frequency, in minutes, with which you want 
your database to receive updates from the server.

4. Click OK.

Eudora Planner now receives server updates from the workgroup server at the 
specified interval.

To force the update of a specific server:
1. From the Define menu, select Servers.

The Edit Servers dialog box appears, listing all the servers to which this user is 
connected.

2. Select the server for which you wish to force the update.

3. Click Update Now.

The server immediately updates the local Eudora Planner database with any 
changes or additions that other users have made since the last update.

You can also force an update by control-clicking the server’s icon in the 
Edit Servers dialog box, then selecting Update Now from the contextual 
menu that appears.

Accessing Workgroup Data
The final step in the process of sharing Events and Contacts is to have each user 
subscribe to categories of Events and Contacts that reside on the workgroup server. 
For information on these tasks, see the Eudora Planner User’s Guide.
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Appendix A

User Configuration Worksheets
This appendix contains two worksheets for you to use in planning your Eudora 
Group Planner installation. You can use these worksheets to collect details about 
each individual user and to set up user groups.

QUALCOMM grants you permission to make multiple copies of these worksheets.
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Name:

Dept.:

Eudora Planner User Planning Worksheet

Title:

Phone:

Fax:

Mobile:

Email:

URL:

Home address:

Home phone:

User Details

Privacy Permissions Granted to Other Users/Groups

ReadUser/Group name: Modify

Modify Access (to Events and Contacts)

Take OwnershipDelete

Other information:

ReadUser/Group name: Modify

Modify Access (to Events and Contacts)

Take OwnershipDelete

ReadUser/Group name: Modify

Modify Access (to Events and Contacts)

Take OwnershipDelete

ReadUser/Group name: Modify

Modify Access (to Events and Contacts)

Take OwnershipDelete

ReadUser/Group name: Modify

Modify Access (to Events and Contacts)

Take OwnershipDelete

ReadUser/Group name: Modify

Modify Access (to Events and Contacts)

Take OwnershipDelete

ReadUser/Group name: Modify

Modify Access (to Events and Contacts)

Take OwnershipDelete

ReadUser/Group name: Modify

Modify Access (to Events and Contacts)

Take OwnershipDelete



Eudora Planner Group Planning Worksheet

Group name:

Group members:

ReadGroup permissions: Modify

Modify Access (to Events and Contacts)

Take OwnershipDelete
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